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Preface ENOVIA PPR (Product-Process-Resource) Hub is a rich object model that is tailored to the complex needs of data and knowledge management in a product development environment. It is based on industry standards as they are being defined by STEP and OMC. To support the more exacting requirements of the Digital Enterprise, the model goes beyond the projected standards by supporting integration across the development life cycle, covering the organization of specifications, product and document structures as the development cycle evolves from initial definition to in-service support. The ENOVIA PPR Hub supports the multiple relationships between objects as they are needed during the development processes so that the users can navigate through the information in the manner best suited to their needs. The relationships can be created by the user, or they can be created by the CAx and other authoring tools necessary during development. ENOVIA PPR Hub foundation is part of ENOVIA V5 product which solutions are implemented within a comprehensive set of five ENOVIA Foundations that cover the complete requirements of a scalable infomation system, extended data management and workflow support, user-based life cycle applications and global access. Here are the five foundations: PPR Hub foundation a data model specifically adapted to the requirements of data management throughout all phases of the product development life cycle. Portal foundation provides tools for graphical visualization, analysis and collaboration. It combines the generic features of the Internet with powerful 3D and 4D graphic display technologies. Life Cycle foundation contains rich user-oriented functions for product development activities from initial specification development through service and end-of-life requirements. Enterprise Architecture foundation



a scalable information system platform that adapts to any size of Digital Enterprise implementation, from and few to many thousands of users. RAD (Rapid Application Development) Environment foundation allows all levels of integration of ENOVIA solutions to enterprise requirements. It contains the tools necessary to federate existing applications into a single-image system that integrates new applications built on the ENOVIA platform with enterprise legacy applications.



Using This Guide The user should be familiar with basic PPR Hub Version 5 Release 4 concepts such as creating a product and managing its data throughout all phases of the product development life cycle. This guide is organized as follows: Basic Concepts: provides the basic PPR Hub notions Glossary: provides definitions of terms that are specific to product creation and management. Index: provides a list of terms specific to product data creation and management.



More Information ENOVIA V5 is a set of information management solutions from ENOVIA Corp. that contribute to implementation of the Digital Enterprise. Combined with world-class product, process and resource definition tools from CAx vendors and resource planning applications from ERP specialists, ENOVIA V5 ensures that digital information can be collected and made available throughout the global enterprise. It is the keystone that unites and supports the product development life cycle with planning and production activities. It provides support for business processes from product specification through logistics planning with both ENOVIA applications and by federating existing enterprise information tools within a consistent framework. ENOVIA V5 solutions are implemented within a comprehensive set of five ENOVIA Foundations that cover the complete requirements of a scalable infomation system, extended data management and workflow support, user-based life cycle applications and global access. ENOVIA V5 implements its Digital Enterprise Vision through delivery of solutions in five "Foundations" families. You may also like to read the following complementary foundation guides: Enterprise Architecture Installation Guide Enterprise Architecture Administration Guide Enterprise Architecture Principles Guide Life Cycle Applications Guides (one guide per role + a Principles Guide) CAD Integration User`s Guide File Exchange User`s Guide Portal User`s Guide Portal Administration Guide



Certain conventions are used in ENOVIA documentation to help you recognize and understand important concepts and specifications.



Conventions Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and understand important concepts and specifications. The following text conventions may be used: The titles of CATIA, ENOVIA & DELMIA documents appear in this manner throughout the text. File -> New identifies the commands to be used. The use of the mouse differs according to the type of action you need to perform. Use this mouse button, whenever you read Select (menus, commands, geometry in graphics area, ...) Click (icons, dialog box buttons, tabs...) Double-click Shift-click Ctrl-click Check (check boxes) Drag Drag and drop (icons onto objects, objects onto objects) Drag Move Right-click (to select contextual menu)



Graphic conventions are denoted as follows: indicates the estimated time to accomplish a task.



indicates a target of a task. indicates the prerequisites. indicates the scenario of a task. indicates tips



indicates a warning. indicates information. indicates the end of a task. indicates functionalities that are new or enhanced with this Release. Enhancements can also be identified by a blue-colored background in the left-hand margin.



Basic Concepts



Configuration



Introduction to Configuration Manufacturing enterprises have always been highly focused on enhancing the profitability of their operations through concerted efforts on improving their product development process and the product production process using numerous tools. Historically, by accomplishing higher levels of efficiency in production, margins have been enhanced that ensured higher levels of profitability. To this end, manufacturing companies have been using MRP, MRPII, and then ERP products to squeeze out every time and cost element in the production process. In addition to all this, in the new paradigm of maximizing profitability, the short cut to maximum profitability remains being able to increase market size through higher levels of product innovation that is compounded with increased market share accomplished through early to market with least cost The product innovation is accomplished through Virtual Product Development Management (VPDM) products suited for conceptual design and early design and the early to market is accomplished through products like the traditional Product Data Management. Product Innovation will result in offering a wider set of end product variants, with greater number of options with lesser number of components and Early to Market will result in capturing a bigger share in the market through reaching the Market first. Usually, each variant of the same product has to be modelized into a new version of this product. This traditional approach has two major disadvantages which are data duplication and a complicated component reuse. Data duplication, besides inconsistency risks between variants and administration costs it involves, impeeds innovation. As a matter of fact, the modification of a product component implies to repeat this operation on each concerned version. It is also plainly evident that data duplication would be impossible on a product having thousands of versions. Configuration management enables to perform a modification on every variants in only one operation: you just have to specify the list of options for which this change is effective. This also means only one operation on the product structure. In addition to this, configuration management allows to generalize the component notion. From a strict versioning point of view, the component has to be totally defined. For example, if a supplier provides a braking system with and without ABS, you have to manage two references and thus create two versions of the final product: one with ABS and one without ABS. Each use of a multi-version component will, in turn, multiply the number of final products to manage. The only solution would be to use very simple components with a small number of versions or even no version at all. The configuration advantage is to reference a component which is not totally defined. In the above example, you could decide to use the "Brake" component without having



to decide to use ABS or not. This decision will be made at the car level and you are then able to ask very complex sub-assemblies with a great amount of variants from your suppliers (internal or external). But a question is still raised concerning the management of so many options (the ENOVIA terminology for "option" is "specification"). The Configuration Engine brings the answer since it enables to: express the specification incompatibilities, e.g. in a small car you can not implement air conditioning and ABS. express the specifications involving other specifications, e.g. you can indicate that the V6 3.0L engine is automatically associated to 17" wheels and ABS brakes. Thanks to this method, you can check that the car chosen by a customer can really be made. This method also enables to partially encapsulate the company know-how by means of a rule dictionary that could be applied to each product. The configuration provides a very precise management of the product life-cycle. When you are working on a configured product, you never remove parts: you log a series of operations (for instance, you add P1, move P2 from position L1 to L2, replace P3 with P4, and so on) to which an applicability is assigned. Then, when you ask for a product specification in particular, all the modifications made to the product are identified. You can easily check a modification, determine the person responsible for it and, in case of an unsatisfactory result, remove the modification. It also possible to link the configuration and the Change Management application in order to manage the rights to perform modifications, to track the work in progress, to create events when a defined level is reached or to create warnings when a delay occurs in a task. Finally, the ENOVIA configuration engine can configure any type of data, i.e. EBOM, MBOM, processes, and so on.



Configuration Engine Concepts Configuration Engine Configuration allows you to manage different views of the same object without having to version it and thus, avoid you to duplicate data. Moreover the configuration improves component reuse inside other components. You are also able to work on several configurations at the same time. This component reuse has another advantage since you just have to implement your changes once: you just make your modifications and specify the expected configuration.



Configurable View You can configure any kind of data (Engineering Bill of Material, Manufactuing Bill of Material, processes, rules, etc.). When you want to make an object configurable, you just have to create a configurable view. A configurable view allows you to manage different views (e.g. design, manufacturing or prototype) of the same object. This is especially usefull when sharing many item instances between several different applicabilities. For example, you can define a configurable view in the Product Class Editor.



Once you have created your configurable view, you can create modifications.



You can create as many configurable views as you want.



Modification A modification is an object used by the configuration engine to record your data changes. This object belongs to a single configurable view and is automatically created when it is necessary. A modification: points to a set of objects has a name and a status; this status is controlled by an action is never deleted belongs to a configurable view. The order in which you create your modifications is important since there are sorted in chronological order.



Applicability Once the changes have been made and recorded in te configuration engine, you may want to specify when these changes are effective. This specification is done by giving an "applicability" to your changes. Take the product structure application as an example: you would edit the current action through the Action Editor, then select the Effectivity menu and finally enter the new applicability. Although the applications may have different ways of managing the applicability, they always use the same panel which ensures that once you know how to specify an applicability for an application, you are able to do it for any other application. Applicability Types The configuration engine supports three kinds of applicability: range, date, specification and milestone. 1. Range The range is used to specify a range interval. The lower bound must be greater than or equal to 1. The upper bound must be greater than or equal to the lower bound. If the upper bound is not valuated, it is then considered as being infinite. 2. Date The date is used to specify a date interval. The rules applied to the date are identical to those applied to the range. 3. Specification Specifications are used to identify the different variants or options of a product. If we take the example of a car, we could find the following specifications: air conditioning, power steering wheel, airbag, etc. Specifications are organized into categories. The "Engine" category, for instance, may have specifications like "1.4", "1.8", "2.0 Diesel" or "3.0 V6". You can also define a list of rules between specifications. There are two types of rules:



Expression These rules are used to check the configuration consistency. Let`s go on with our car as an example: in a small car, you may want to add a constraint avoiding airbag and air conditioning simultaneously. You could then create the following rule: Airbag AND NOT Air Conditioning Inclusion An inclusion enables you to specify that a specification requires many other specifications. For instance, if you want to specify that, when you select the 3.0 V6 engine, you automatically select the 17" wheel and the ABS. To do so, you would create the following inclusion: IF



3.0 V6



THEN



17" Wheel, ABS



4. Milestone Milestones represent a date that can evolve, for example when you want to modify a deadline.



In the above example, suppose we assign the following date to M1: 04/27/2000. This date corresponds to the task deadline. In case of a delay, you can easily modify the deadline since you just have to change the milestone M1 from 04/27/2000 into your new date, 05/02/2000. Each date occurrence associated to this milestone will be then automatically modified according to the new date, thus saving you a lot of time.



Mixing Different Kinds of Applicability You are allowed to mix the three kinds of applicability detailed above. For example, let`s suppose you want to define that air conditioning is optional in 1999 model but serial in 2000 model, you will write: Date (1999-01-01, 1999-12-31) (2000,01-01,00)



AND



Air Conditioning



OR



Date



Extended Effectivity This task will introduce the effectivity and extended effectivity concepts.



An extended effectivity is the association of an applicability and a domain name. The applicability contains a complex boolean expression of range, date and specification, e.g. Range(1, 20) & Option1 | Option2 | Date(d1, oo)



Here is an example of two extended effectivities that could be contained in a modification concerning planes: extended effectivity 1



Engineering R (10-100)



extended effectivity 2



Manufacturing R (15-100)



where: "Engineering" and "Manufacturing" represent the domain (or "effectivity type") "R" represents the effectivity, "range" is our example the numbers between ( ) represent the effectivity value In the above example, the extended effectivity 1 means that this filterable object will be valid for the planes from range 10 to 100 belonging to the Engineering domain. A modification may have several extended effectivities but only one per domain. This is illustrated by the following schema:



Filter The following concept describes the filter and the rules involved in its definition.



Configuration enables you to visualize the variants of a Product through the application of filters. These filters restrict the view on a Product using applicabilities defined for each Part Instance. Applicabilities are sets of effectivity expressions which take one of the following forms: Range of dates Range of products Specifications



A filter is an unlimited list of configuration criteria that will be applied to a Configurable View. When defining a filter, you also have to specify a domain (Engineering, Manufacturing, etc.), for example:



In our example, the filter will show you the planes from range 15 to 100 with a Long Range type and a Snecma engine.



Rules Specifications are organized into categories. The administrator will define a set of categories and for each category he will define some specifications. specification: maps the "option effectivity" specification category: defines a classification of specification. For example, the category "seat" may have the following specifications: standard, sport, etc. Each specification must be associated to a specification category. specification expression: boolean expression of specifications. Spec 1 AND Spec 2 OR Spec 3



This object is defined in a specification inclusion specification inclusion: defines the rule If SpecExpression THEN Spec 1, Spec 2 ...



When the specification inclusion is composed of only one specification, it is called a package. Specifications are rules specific to the ENOVIA customer. It is a kind of company dictionary.



These rules are applied in the following order: package and specification inclusion mandatory specification expression You can use a specification inclusion to check the configuration consistency.



If you want to reuse your filter, you will have to save it under a name of your choice. This object is then called a Configuration Handler object.



Configuration Handler This task will introduce the configuration handler.



A Configuration Handler defines a particular configuration of a Product by specifying the values for the set of corresponding specifications and effectivity expressions. The effect of applying a Configuration Handler is to filter the Product to display only those instances that meet the criteria of the Configuration Handler. It enables you to concentrate on the configuration tasks concerning a particular part and to reuse configurations of component parts that have been created by the owners of those parts. To extract a technical configuration, you can choose a Configuration Handler rather than listing all the combinations of effectivity expressions that would otherwise be necessary. Configuration Handlers can serve, for example, to define product baselines, "best-so-far" design work or any other predefined configuration. Create a Configuration Handler Creating a Configuration Handler can be considered to consist of two basic steps: 1. defining the effectivities that will be applied to the product at the root level 2. give a name to the configuration handler Configuration Handlers are created in a product context.



Use a Configuration Handler to define a Configuration You can use a Configuration Handler to define a configuration since the effectivities for sub-assemblies have already been defined and you can thus configure your part in one simple interaction.



A configuration handler is unique. Any modification made to it will modify its values everywhere it is used in other Configuration Handlers.



Action Flow



Action The purpose of this task is to introduce two concepts: action and associated object.



Actions - Overview An action is used in ENOVIA V5 to request, define and track a modification to a product and to dispatch tasks between people. It contains all the information (methodological documentation, affected parts, configuration specifications, CAD/CAM models, electronic documents) necessary to implement the requested modification. An action consists of the following elements: an identifier a description an owner a priority a status a target date a reference context associated objects You can customize the action at the object level by adding attributes or components. The action behavior is customizable as well via the status graphs. The action flow enables you to manage links between actions (hierarchical links, peer-to-peer links) and to control the configuration.



Associated Objects An associated object allows you to include any document type in an action. Its role is to create a link between the action and the external document to be included. The associated object has several attributes: name, status, flow (input or output), etc. Here is a schema illustrating the relationship between actions and associated objects:



Concerning the status, you can apply the same methods as those applied to actions: promote: advance the status to the next status defined in the status graph demote: move the status back to the previous status defined in the status graph transfer: assign the associated object to another user reject: remove the associated object from the current workflow Associated objects are customizable. You can define your own attributes, default values, visibility, writeability.



Customization This task will help you to understand the action customization concept. You can customize an action by creating your own action types with their own attributes and status graphs. A status graph is a series of states linked together. Each action type may have different status graphs with different behaviors. All the major events which the action undergoes (creation, promotion, transfer, completion, association of documents) are recorded and can be used to communicate the progress of a modification throughout its life cycle for later historical analysis. When you want to modify the status of an action, you have to promote the action. Between each transition (i.e. from one state to another) you can associate conditions and commands. A condition is a code enabling to check that a user is authorized to promote an action. A library of conditions and commands is delivered with ENOVIA V5. The diagram below shows an example of a status graph:



The methods which can be applied to an Action are the following ones: Promote Promoting an Action advances the status to the next status defined in the status graph. You can indicate the "maturity" status of an action by promoting it through various statuses. The maturity stages are defined by your System Administrator according to your business needs. You can also have different maturity statuses for different types of Actions. Certain checks or validations can also be made automatically when promoting an Action. These are programmed in to ENOVIA V5 by your System Administrator Demote Demoting an Action moves the status back to the previous status defined in the status graph. You can demote the "maturity" status of an Action through previously-defined stages using the Demote function. The maturity statuses are defined by your System Administrator according to your particular business needs. You can also have different maturity statuses for different types of Actions. Certain checks or validations can also be made automatically when demoting an Action. These are programmed in to ENOVIA V5 by your System Administrator Reject Rejecting an Action removes the Action from the current workflow. It changes the status of the Action to "Rejected", in which case the Action is considered closed and no further work may be carried out on it. You would reject an Action if, for example, you review a proposed Action and do not agree that the changes should be implemented. Certain checks or validations can be made automatically when rejecting an Action. These are programmed into ENOVIA V5 by your System Administrator Transfer Transferring an Action enables you to assign the Action to another user. You can transfer an Action to another ENOVIA V5 user - if, for example, you want to assign the work to be done for a particular product change to that person. You can transfer an Action to a Person or an Organization. If you transfer the Action to a Person, only that person will be able to update or save the Action. If you transfer the Action to an Organization, anyone belonging to that Organization will be able to update or save the Action.



An action has an associated maturity status. Your system administrator can customize the maturity statuses to fit your business requirements. The default statuses are Proposed, In Work and Completed. If you follow this general sequence, any objects that you add, edit or remove from your product structure will automatically be added to the Action that you associated to the Configurable View. The objects will be shown as output objects in the Action. Also, when you have finished your work on the Action and you have promoted it to its highest status (Completed, by default), the effectivity defined in the Action is propagated to all modified objects of the Product Structure.



Links The following task aims at giving you a short presentation of action links. Managing actions means also managing links between these actions. There are two kinds of action link: bi-lateral link from an action to another oriented link allowing to put a constraint from one action to another as well as Perth management Let`s look at the schema below to understand how these different types of links can interact which each other:



You can also use two particular links called "Cancel" and "Supersede". 1. A Supersede link lets you replace an action with another one (for instance, when you want to modify an effectivity). 2. A Cancel link lets you specify that an action being replaced with another one will no more be taken into account.



Action and Configuration Action and configuration are interdependent. Each time you associate a configurable view to an action, a modification is created. From a user interface point of view, the action controls the modification applicability through the Effectivity menu item in the Action Editor (local menu available when you select the Product tab). An action simplify the configuration management which could be very complicated otherwise. You just have to set your "current action" and this action will perform all the other operations related to the configuration management.



Manufacturing BOM



Manufacturing Bill of Material A Manufacturing Bill of Material (MBOM) is a manufacturing decomposition of a product. This autonomous data structure is distinct from the Engineering Bill of Material (EBOM) and is designed to manage a manufacturing breakdown of products and to provide specifications to the Process definition of the product.



Basic Definitions The two major concepts involved in MBOM are: Manufacturing Plan The Manufacturing Plan represents the part assembly concept. It can be either a basic component or an assembly of other Manufacturing Plans (basic or not). A "top level" Manufacturing Plan is the object defining the final assembly for a given product. For example, an engine can be seen as an assembly Manufacturing Plan if it is decomposed in the following Manufacturing Plans: Spark, Crankshaft and Cylinder Head. Manufacturing Instance A Manufacturing Instance represents the use of a Manufacturing Plan as a component of another (more complex) Manufacturing Plan. Therefore, an assembly Manufacturing Plan can be seen as the association of all its components. For example, A V6 engine takes six Manufacturing Instances from the Spark Manufacturing Plan and one Instance from the Cylinder Head Manufacturing Plan. A typical car takes four Instances of the Wheel Manufacturing Plan and one Instance of the Hood Manufacturing Plan.



Manufacturing Plan and Traceability A Manufacturing Plan does not represent any intermediate state a something being produced. Only a subset of all possible intermediate states qualify as Manufacturing Plan. These subsets are those which need to be identified for traceability. For example, a seat without might not be considered as a Manufacturing Plan whereas a finished seat, i.e. with should be seen as a Manufacturing Plan.



Manufacturing Plan and Reuseability A Manufacturing Plan is a kind of "reference" object that can be: reused many times inside the same product shared among different products Let`s compare two different Manufacturing Plans, Bolt and Air Conditioning, to illustrate this concept: Bolt may have many uses in a given car and Air Conditioning may be used in different car models.



Manufacturing Plan and Process MBOM provides specifications to the process definition of the product. Different manufacturing processes exchange a Manufacturing Plan between them, this Manufacturing Plan being used as an output for some of them (this corresponds to what the process must produce) or as an input for the others (i.e. what the process consumes). A Manufacturing Plan having component instances in the MBOM decomposition represents an assembly. Any Manufacturing Instance composing a Manufacturing Plan is considered as a consumed resource in the Manufacturing Plan. Each Manufacturing Plan leaf in the MBOM breakdown represents a basic component. The same Manufacturing Plan may be manufactured by different processes (depending on the plant, for example).



Other MBOM Properties As we have explained it before, a Manufacturing Bill of Material is a product decomposition that can be managed in two ways: 1. management independent from any EBOM decomposition, i.e. an autonomous mode. 2. management related to an existing EBOM as a strongly related but slightly different product decomposition. The Manufacturing Bill of Material contain information that are not included in the EBOM. For example: some components have to be mounted before other components



the MBOM supports variants that are unknown to the Engineering, e.g. a variability between plants in the product manufacturing MBOM objects contain supplier, cost, weight and art number information.



Product Structure



Product Management Concepts Product Class Structure Product Component Structure Instance Structure Zone Documents and Folders Views and Layouts Contexts Queries



This section describes the concepts and aspects of the ENOVIA V5 applications applicable to the management of your products. The following schema ilustrates some of the concepts involved in product management. Click the sensitive areas to read the corresponding information.



Product Class Structure The Product Class Structure captures the product ranges for your business. This structure comprises the following elements: Product Class Root This is the highest leaf in the structure and it is used to categorize your products. For example, you may have a product class root of Cars. Product Classes Product classes allow you to group products that share similar attributes, for example you may have a class for Cars and one for Commercial Vehicles. You may have more than one type of Product Class Root, e.g. Cars and Engines. Adding further levels of classes allows you to refine the level of granularity, for example in the class of Cars you may have classes of Convertible, Sedan, etc. Products Products are the lowest leaves of your structure. A product is typically a commercial or saleable item, for example a GrandAm and a SunFire.



Table 1. Example of a Product Class Structure



Because your company`s products will not generally change on a day-to-day basis, the Product Class hierarchy will most likely be set up and maintained by the Definition Engineer. The Product Class Structure is managed using the Product Class Editor Application.



Product Component Structure The Product Component Structure resides under a Product. It will typically comprise the major sub-assemblies of your product, for example a product component for a GrandAm may be a Wheel or a Chassis. Just as for Product Classes, you can define a hierarchy of Product Components to allow you to refine the granularity level.



Table 2. Example of a Product Component



This structure too will not generally change day to day, so the Definition Engineer will most likely manage this structure. The Product Component Structure is managed using the Product Editor Application.



Instance Structure Instances are the actual usage of parts, sub-assemblies or other objects in a product. Many instances of a part can exist in a product, for example you may have 50 instances of the part "Screw". Additionally, you can instance a product within a product. For example, you may have a chassis that is used in your 2 Door Small Car Product.



Table 3. Example of instances



The instance structure and their assemblies is likely to change frequently during design and development phases of the product life cycle. Therefore this structure will typically be managed by the Designer. The Instance Structure is managed using the Product Editor Application.



Zone A Zone is a geographical volume defined in your product. Zones allow you to focus on specific areas so that all instances within the "Chassis" zone (if these are defined) can be easily selected. Zones are managed using the Product Editor Application.



Documents and Folders Documents are files that are related to objects in your structure. These files are referenced through an access method. Typically document data can be: CATIA models other CAD models drawings text files images etc.



You can add document data at any level of the Product Structure. Documents are added into "Folders" that are then attached to the required part of the Product Structure. A Folder may comprise several Documents. That same Document may be inluded in several folders, i.e. folders that may be used elsewhere. In addition, several folders may be attached to the same object in the Product Structure. A Folder is filterable through the configuration mechanism. Documents can be viewed or edited through appropriate viewers or editors. The choice of viewers and editors will be defined by the ENOVIA V5 Administrator.



Views and Layouts The Product Editor is divided into a number of view displays and view types. View Display



You access these views in the Product Editor by selecting the Tools -> View Display commands.



Each "View" looks at a different level in your product hierarchy. These are :



Product Component View - manages your Product Component structure Instance View - manages your instance structure Images View - contains your loaded images



View Type



You access these views in the Product Editor by selecting the Tools -> View type commands.



You can choose between the following views: Tree view PDM view B view



Contexts The layout and expansion of your Product Structure can be stored as a Context to allow you to retrieve your working view on the structure quickly and easily. To do so, click the Save a Context icon



in the Product Editor Application.



When you save a context, you are also saving any changes that you have made to the Product Structure.



Queries You can search for ENOVIA V5 objects by entering search criteria in the columns of a query dialog box.



Part Management Concepts Part management consists of the creation, issuing, versioning and ownership of Part References and their Instances. Part Versions, Part Masters, Part References and Part Instances are used to describe types or different uses of Part data. The following concepts describe the relationships between these items.



Part Master Part data common to all part versions is stored in a common object to facilitate management and minimize redundancy. This object is the Part Master. You can create new parts as being "issued from" existing parts where they have similar characteristics, and it is useful to be able to create a separate part but still maintain a link to the original. In fact, you can "issue from" most ENOVIA V5 objects (products, item instances, etc.) from equivalent objects where you feel this is meaningful.



Part Version The Part Version describes all the data about a part or assembly specific to a particular version. You may typically version a part after a modification where the fit, form or function has not fundamentally changed, for example you change the material specification of a part and version it from A to B.



Part Reference The Part Reference comprises the Part Master and the Part Version data. Changing either one of these will create a new Part Reference. The diagram below shows the relationship between Part Master, Part Version and Part Reference:



Part Instance Each occurrence of a Part Reference in a product is separately identified as a Part Instance. The Part Instance stores data that is specific to the occurrence such as its positioning matrix (x, y, z), its relationship to other Part Instances, etc. A Part Instance can also represent an assembly or group of Part Instances. In this case, its links to constituent parts or sub-assemblies are also stored. When a Part Instance is created, it is added to the product and, optionally, to a product component.



Locking and Unlocking Locking parts prevents other users from changing the data while you are working on it. When you have finished your modification you can unlock the part to allow another user to lock the part and perform his/her modifications, and to allow for your changes to be propagated throughout the product structure. It is possible for you to query a locked part to establish its lock status and which user has locked it.



Alternate Parts An Alternate Part is one that can be used instead of another. If an Alternate part is defined for an instance, it is applied to all other instances of the part. An example of an Alternate Part might be a bolt with a different head style.



Alternate Part instances have the same position in the DMU as the instance it replaces, thus the two parts are functionally interchangeable.



Substitute Instances A Substitute Instance is similar to an Alternate Part, except that the substitution is only valid for the selected instance. The positioning data for the Substitute Instance may be different to the instance it replaces. The diagram below shows this concept:



Glossary A action



An action may be used to control and track any modification made to a product. It can also be seen as a folder containing a set of objects



Action Editor



The ENOVIA V5 window in which the user manages actions



action ID



An automatically generated number that uniquely identifies an action. This number can also be customized to conform to in-house standards



assembly



A hierarchical organization of parts consisting of a part with one or more component parts. Component parts may themselves contain component parts



associated object



An associated object allows you to reference any kind of document within the action. An associated object has an owner and a status. Therefore you can manage its lifecycle with a status graph



B bill of material (BOM)



A listing of the product structure components



C configurable object



A view of the object you want to configure in the configuration modeler



configurable view



An identification of a set of modifications associated with the product



configuration



A snapshot of the bill of material that defines a deliverable product



context



A stored product expansion and Product Editor layout



D demotion



To move the action status back to the previous status defined in the status graph



E effectivity expression



A boolean expression containing Range, Date and Specification



engineering change



A formal process used for managing changes to be made to product structures and documents



I instance



An individual occurrence of a part in an assembly



L level



The relative hierarchical position of a component within a product assembly



M manufacturing A manufacturing view of the Product Structure bill of material manufacturing A manufacturing expression of the usage of a manufacturing plan instance within a higher-order manufacturing plan manufacturing A manufacturing equivalent of a part reference plan milestone model
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An occurrence of one product within the product structure of another product



product structure



The set of multi-level relationships that together constitute the bill of material of the product
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properties



Attributes associated to an object
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V view
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A predefined bounding ball for a product. Its name can be referenced by the user
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